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Este documento se proporciona a los clientes que han adquirido un equipo
SCIEX, para que lo usen durante el funcionamiento de dicho equipo SCIEX.
Este documento está protegido por derechos de propiedad y queda estrictamente
prohibida cualquier reproducción total o parcial, a menos que SCIEX lo autorice
por escrito.
El software que se describe en este documento se proporciona bajo un acuerdo
de licencia. Está legalmente prohibida la copia, modificación o distribución
del software en cualquier medio, a menos que se permita específicamente
en el acuerdo de licencia. Además, es posible que el acuerdo de licencia
prohíba igualmente desensamblar, realizar operaciones de ingeniería inversa o
descompilar el software con cualquier fin. Las garantías son las indicadas en ese
documento.
Algunas partes de este documento pueden hacer referencia a otros fabricantes o
sus productos, que pueden contener piezas cuyos nombres se han registrado
como marcas comerciales o funcionan como marcas comerciales de sus
respectivos propietarios. El uso de dichos nombres en este documento pretende
únicamente designar los productos de esos fabricantes suministrados por SCIEX
para la incorporación en su equipo y no supone ningún derecho o licencia de uso,
ni permite a terceros el empleo de dichos nombres de productos o fabricantes
como marcas comerciales.
Las garantías de SCIEX están limitadas a aquellas garantías expresas
proporcionadas en el momento de la venta o licencia de sus productos, y son
representaciones, garantías y obligaciones únicas y exclusivas de SCIEX. SCIEX
no ofrece otras garantías de ningún tipo, expresas o implícitas, incluyendo, entre
otras, garantías de comercialización o adecuación para un fin específico, ya se
deriven de un estatuto, cualquier tipo de legislación, uso comercial o transcurso
de negociación; SCIEX rechaza expresamente todas estas garantías y no asume
ninguna responsabilidad, general o accidental, por daños indirectos o derivados
del uso por parte del comprador o por cualquier circunstancia adversa derivada
de este.
Se trata de un sistema para uso diagnóstico in vitro. Producto(s) no
disponible(s) en todos los países. Para obtener más información, póngase en
contacto con el representante de ventas local o consulte sciex.com/diagnostics.
Rx only.
Es posible que los productos no estén disponibles en todos los países. Si
desea obtener más información, póngase en contacto con el representante
local de ventas o consulte el sitio web sciex.com.
Las marcas comerciales o marcas registradas aquí mencionadas, incluidos
sus correspondientes logotipos, son propiedad de AB Sciex Pte. Ltd. o sus
respectivos propietarios, en Estados Unidos y algunos otros países (consulte
sciex.com/trademarks).
AB Sciex™ se usa bajo licencia.
© 2022 DH Tech. Dev. Pte. Ltd.
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Tutorial de ajustes manuales

Los usuarios aprenderán a ajustar y calibrar manualmente un espectrómetro de masas en el
modo cuadrupolo y en el modo de trampa de iones lineal (LIT).

Requisitos previos

Los usuarios podrán:

• Crear un método de adquisición

• Enviar un lote

Se recomienda utilizar los siguientes equipos y dispositivos periféricos:

• Un perfil de hardware activo que contiene el espectrómetro de masas y la bomba de
jeringa.

• PPG o soluciones de ajuste adecuadas.

Acerca de los ajustes
Los ajustes optimizan el rendimiento de la resolución y la intensidad del espectrómetro de
masas. Cuando ajuste un espectrómetro de masas, realice lo siguiente:

• Ajuste los valores de desviación de la resolución para ajustar la intensidad y la resolución
de las masas de calibración (solo para el modo cuádrupolo).

• Seleccione las masas que desee calibrar. Si es necesario, puede agregar y eliminar
masas de la lista de calibración.

• Cree uno o varios conjuntos de estándares de calibración únicos. Un conjunto de
estándares de calibración debe constar de al menos dos compuestos para los extremos
alto y bajo del rango de masas de interés.

Durante el proceso de ajuste y calibración del espectrómetro de masas, los cambios en
la configuración se guardan en el archivo InstrumentData dentro de la carpeta API
Instrument. Es necesario utilizar los parámetros predefinidos de la carpeta de métodos API
Instrument, ya que son parámetros optimizados por el representante del servicio técnico
durante la instalación.

Tabla 1: Frecuencia de ajuste

Calibración Optimización de la resolución

Tipo de
análisis

Frecuencia Manual/
automatizada

Frecuencia Manual/
automatizada

Q1 y Q3 3 a 6 meses Ambas 3 a 6 meses Ambas
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Tabla 1: Frecuencia de ajuste (continuación)

Calibración Optimización de la resolución

Tipo de
análisis

Frecuencia Manual/
automatizada

Frecuencia Manual/
automatizada

LIT Cada dos
semanas, según
sea necesario

Ambas 3 a 6 meses Solo
automatizada

Resolución y sensibilidad
El software utiliza valores predefinidos de resolución unitaria, alta, baja y abierta para el
modo cuádrupolo. En el caso de los análisis en modo cuádrupolo, existe un equilibrio entre
la resolución y la sensibilidad. Cuanto más ancho sea el pico, más intenso será también.
Para los picos más estrechos, ocurre lo contrario. La resolución y la sensibilidad LIT (trampa
de iones lineal) no guardan ninguna relación debido al modo en que funciona la trampa de
iones lineal.

Los valores de desviación indicados a continuación para las resoluciones baja y abierta son
los habituales. No obstante, se pueden modificar de acuerdo con los procedimientos de
funcionamiento estándar.

• Resolución baja (tensión reducida con respecto a la resolución unitaria): 0,03

• Resolución abierta (tensión reducida con respecto a la resolución unitaria): 0,30

Sugerencia: Los ajustes de resolución se pueden comprobar o editar en la pestaña
Resolution del cuadro de diálogo Tuning Options. Para abrir el cuadro de diálogo, en el
modo Tune and Calibrate, haga clic en Tools > Settings > Tuning Options.

Ajuste manual de la resolución
El software cuenta con cuatro parámetros de resolución para los cuádrupolos: unitaria, alta,
baja y abierta. Las anchuras de pico se establecen en 0,7 (± 0,1 Da de anchura del pico a
media altura) para la resolución de la unidad y en 0,5 (± 0,1) para la resolución alta. Esto
se lleva a cabo ajustando las desviaciones de resolución. El software calcula los parámetros
de resolución baja y abierta a partir del parámetro de resolución unitaria. Los ajustes a las
desviaciones de resolución se efectúan en la pestaña Resolution de Tune Method Editor.

La resolución Q1 varía para los análisis LIT en función del análisis utilizado. La resolución
Q1 es fija para los análisis ER y EMS. La resolución Q1 para los análisis ER está
configurada de forma predefinida como abierta, lo que permite una anchura razonable de
las masas en la LIT.

Para los análisis EPI y MS3, establezca la resolución Q1 en cualquiera de los parámetros
de resolución seleccionados. En general, se establece la resolución unitaria para este
parámetro, pero puede definirse en una resolución inferior para permitir una ventana de
masa más amplia en la celda de colisión y mostrar más isótopos, o bien para aumentar la
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sensibilidad de la misma forma que si se ejecutase un análisis de MRM a una resolución
baja.

Para los modos de análisis LIT, la resolución depende de la velocidad del análisis. En
general, cuanto más baja sea la velocidad de análisis, mejor resolución.

Ajustar la resolución en los instrumentos LIT
La resolución de un pico está determinada por la masa y la anchura de ese pico. En el modo
LIT, la resolución depende de la velocidad con la que los iones se expulsen de la LIT en
función de la masa. Para cambiar la sensibilidad y la resolución de los tipos de análisis LIT,
utilice la función Optimización del instrumento. Consulte el documento Guía de usuario del
sistema o la Ayuda del software Analyst MD.

Calibración de masa
La calibración de masas es el proceso mediante el que se asignan los valores correctos
de la relación masa-carga a los picos de masa. Realizando una calibración de masas con
un estándar de calibración, como el glicol de polipropileno (PPG), compare los resultados
con una calibración anterior, para determinar cuánto se aproximan a los valores teóricos los
valores de la relación masa-carga de los picos observados. Actualice la calibración anterior
o, lo que es más habitual, sustitúyala por la calibración nueva.

Seleccione varias masas cuando calibre análisis Q1, Q3 y todos los análisis LIT para cada
polaridad. Los resultados se almacenan en una tabla de calibración. Cuando se realiza
una calibración de masas, se actualiza la tabla de calibración con los nuevos valores de
DAC (convertidor digital-analógico, por sus siglas en inglés) a partir de la nueva calibración.
Los valores CAD de las masas que ya figuran en la tabla de calibración se actualizan.
Todos los datos de las masas no calibradas en la calibración actual se conservan, pero
no se utilizan. Si se sustituye la calibración de masas, se sustituyen todos los valores de
calibración anteriores de todas las masas seleccionadas para usarlas.

Realice una calibración de masas utilizando un espectro recién adquirido o utilice un
espectro de un archivo de datos almacenado.

Durante una calibración de masas, el software:

1. Busca el pico más amplio en el rango de búsqueda de cada masa seleccionada.

2. Obtiene los valores de masa, intensidad y anchura de pico.

3. Compara la masa registrada con la masa prevista y calcula el desplazamiento, si lo hay.

4. Compara la anchura de pico con la anchura de pico objetivo.

5. Compara la intensidad con la calibración anterior.

6. Muestra los resultados en formato de gráfico y texto.

7. Guarda la tabla de calibración en el archivo de datos del instrumento en la carpeta
<Drive>:\Analyst Data\Projects\API Instrument\Instrument Data.

Tutorial de ajustes manuales

Tutorial de ajustes manuales
IVD-IDV-05-0247-ES-D

Software Analyst MD
7/18



Calibración de masas manual
Una vez ajustadas manualmente las resoluciones de los cuadrupolos Q1 y Q3, compruebe
la calibración. Los cambios realizados en los parámetros durante una optimización de la
resolución pueden afectar a la calibración de masas anterior.

El informe de calibración muestra tres gráficos: el desplazamiento de las masas, la anchura
de pico y la diferencia de intensidad.

• El gráfico de desplazamiento de las masas muestra la diferencia entre las masas
medidas de la calibración actual y las masas reales de la tabla de referencia.

• El gráfico de anchuras de pico muestra la anchura de pico de cada masa comparada con
la anchura objetivo seleccionada en el método de adquisición.

• El gráfico de diferencia de intensidad muestra la diferencia de intensidad entre la
calibración anterior y la calibración actual.

El ajuste y la calibración tan solo deben llevarlos a cabo operadores con experiencia, y los
parámetros de ajuste del deben determinarlos los representantes del servicio técnico.

Asistencia técnica
SCIEX y sus representantes cuentan con un equipo de especialistas técnicos y de servicio
totalmente cualificados en todo el mundo. Ellos sabrán resolver sus dudas y preguntas sobre
el sistema y cualquier problema técnico que pueda surgir. Para obtener más información,
visite el sitio web sciex.com.

Ajustes y calibración manuales en el modo
cuadrupolo
Para ajustar y calibrar correctamente el espectrómetro de masas, ajuste la resolución y
realice una calibración de masas.

Es necesario un método de adquisición diferente para cada tipo de análisis que utilice una
solución de calibración en particular. Para la calibración en modo positivo y negativo, se
utilizan diferentes soluciones de calibración. Si el análisis es un subconjunto tanto del tipo
de análisis como de la polaridad, el usuario también puede ajustar solamente un cuadrupolo,
polaridad o tipo de resolución, en lugar de llevar a cabo el proceso de ajuste y calibración
completo para todas las combinaciones de cuadrupolo, polaridad y tipo de resolución.

Siga los procedimientos en el orden especificado:

1. Seleccionar un método de adquisición

2. Ajuste de la resolución

3. Realizar una calibración de masas en el modo cuadrupolo

Seleccionar un método de adquisición
1. Cree un proyecto para guardar los métodos de calibración y los resultados.
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Puede tratarse de un proyecto específico para el proceso de ajuste o puede formar
parte de un proyecto de trabajo.

2. En la barra Navigation, en Tune and Calibrate, haga doble clic en Manual Tuning.

3. Cree un método de adquisición adecuado en Manual Tune o vaya a la carpeta
API Instrument y abra el método de adquisición para la calibración si se utiliza un
instrumento de la serie 3200MD.

Sugerencia: (Solo aplicable a los instrumentos de la serie 3200MD) El software
no se instala con los métodos de adquisición predeterminados para llevar a cabo
optimizaciones a una resolución alta. No obstante, la única diferencia entre estos
métodos y los métodos específicos de la resolución unitaria (Q1PosPPG.dam,
Q1NegPPG.dam, Q3PosPPG.dam y Q3NegPPG.dam) es el tipo de resolución. La
primera vez que ajuste el espectrómetro de masas y tenga que utilizar los métodos
de alta resolución, abra los métodos de resolución de la unidad, cambie el tipo de
resolución a alta y, a continuación, guárdelos con un nombre distinto, por ejemplo,
Q1PosPPG_alta.dam.

4. Infunda de 5 a 10 µl/min de solución de PPG para ajustar Q1 y Q3 en modo positivo, o
solución de PPG 3000 para ajustar Q1 y Q3 en modo negativo.

Sugerencia: Copie el método, de manera que pueda conservar el método original para
el representante del servicio técnico.

5. Seleccione un proyecto nuevo de la lista de proyectos y, a continuación, guarde el
método con el mismo nombre.

Ajuste de la resolución
Asegúrese de que la pulverización es estable.

1. En la pestaña MS del Tune Method Editor, asegúrese de que la casilla de verificación
MCA está seleccionada.

2. En el campo Period Summary de la sección Cycles, escriba 10.

3. Haga clic en Start.
Se abrirá un panel de espectros de masas en la parte inferior de la ventana Manual
Tune.

4. Una vez que el espectrómetro de masas está en estado de reposo, haga clic con el
botón derecho en el panel del espectro de masas y, a continuación, haga clic en Open
File.
Aparecerá una ventana nueva, en la que se abrirá un panel de datos de espectro de
masas por cada masa del método.

5. Haga clic con el botón derecho en uno de los paneles de datos y, a continuación, haga
clic en List Data.
Se abrirá un panel nuevo con todos los datos del espectro. Este panel contiene las
pestañas Data List, Calibration Peak List y Peak List.

6. Abra la pestaña Calibration Peak List.
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Sugerencia: Esta pestaña solo se muestra si está seleccionada la opción
correspondiente para mostrarla. Para ver la pestaña Calibration Peak List, haga clic
en Tools > Settings > Appearance Options. En la pestaña Miscellaneous, seleccione
la casilla de verificación Show Mass Calibration Peak List y luego haga clic en OK.

7. Si las masas objetivo que aparecen en la lista de picos de calibración no coinciden
con las masas mostradas, haga clic con el botón derecho en Calibration Peak List,
haga clic en la lista Reference correspondiente y, a continuación, haga clic en Use as
Reference.

8. Revise los datos de la Calibration Peak List.

Nota: Si los valores de la columna Width (Da) son 0,7 ± 0,1 Da para la resolución de la
unidad o 0,5 ± 0,1 Da para la resolución alta, la resolución es aceptable.

• Si la resolución es aceptable, continúe con el paso 14.

• Si los valores no se encuentran dentro del intervalo de tolerancia necesario, continúe
con el paso 9.

9. Cierre los paneles y, a continuación, en Tune Method Editor, abra la pestaña Resolution.

10. Haga clic en Advanced.

Se abrirá el cuadro de diálogo Tabla de resoluciones. Este cuadro de diálogo enumera
las masas pico de calibración y los valores de desviación de la resolución del análisis
específico.

11. En el caso de masas que no se ajusten al criterio de anchura de pico de 0,7 ± 0,1
Da para la resolución de la unidad o de 0,5 ± 0,1 Da para la resolución alta, ajuste la
desviación de la forma siguiente:

• Si el pico es demasiado ancho, aumente la desviación en 0,05 o menos.

• Si el pico es demasiado estrecho, disminuya la desviación en 0,05 o menos.

12. Haga clic en Apply.
Los cambios se guardan en el archivo InstrumentData.

13. Haga clic en Close.

14. Repita los pasos 1 a 8 para todos los picos de masa hasta que cada uno de los picos en
la lista Calibration Peak List cumpla el criterio de anchura de pico de 0,7 ± 0,1 Da para
la resolución unitaria, o de 0,5 ± 0,1 Da para la resolución alta.

15. Haga clic en Close.

Realizar una calibración de masas en el modo cuadrupolo
1. En la barra Navigation, en Tune and Calibrate, haga doble clic en Manual Tuning.

2. En la pestaña MS del Tune Method Editor, asegúrese de que la casilla de verificación
MCA está seleccionada.

3. En el campo Period Summary de la sección Cycles, escriba 10.

4. Haga clic en Start.
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Se abrirá un panel de espectros de masas en la parte inferior de la ventana Manual
Tune.

5. Una vez que el espectrómetro de masas está en estado de reposo, haga clic con el
botón derecho en el panel del espectro de masas y, a continuación, haga clic en Open
File.
Aparecerá una ventana nueva, en la que se abrirá un panel de datos de espectro de
masas por cada masa del método.

6. Haga clic con el botón derecho en uno de los paneles de datos y, a continuación, haga
clic en List Data.
Se abrirá un panel nuevo en el que se muestran todos los datos del espectro. Este
panel contiene las pestañas Data List, Calibration Peak List y Peak List.

7. Abra la pestaña Calibration Peak List.

Sugerencia: Esta pestaña solo se muestra si está seleccionada la opción
correspondiente para mostrarla. Para ver la pestaña Calibration Peak List, haga clic
en Tools > Settings > Appearance Options. En la pestaña Miscellaneous, seleccione
la casilla de verificación Show Mass Calibration Peak List y luego haga clic en OK.

8. Revise los datos de la pestaña Calibration Peak List. Si el valor de la columna Mass
Shift (Da) es superior a 0,1 Da para cualquiera de las masas, continúe con el paso
siguiente. En caso contrario, habrá finalizado la calibración de masas.

Nota: Las etiquetas de picos del gráfico son los valores de ápice, pero los valores de
pico indicados en la columna Found At de la pestaña Calibration Peak List son valores
de centroides. Si algún pico no es perfectamente simétrico, el valor de ápice y el del
centroide para ese pico pueden ser ligeramente diferentes. Los valores de centroide
deben ser lo más exactos posible para la calibración.

9. Haga clic en cualquier punto de uno de los paneles de espectro de masas.

10. Haga clic en Tools > Calibrate from Spectrum.
Se abre el cuadro de diálogo Mass Calibration Option.
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Figura 1: Cuadro de diálogo Mass Calibration Option

11. En la lista Standard, haga clic en PPGs Pos. o PPGs Neg. según la polaridad indicada
por el método de adquisición utilizado.

12. Los parámetros predefinidos de búsqueda de picos son adecuados para la mayoría de
los casos. Si desea modificarlos, haga clic en un campo y, a continuación, escriba los
valores nuevos.

Nota: En espectrómetros de masas cuyo rango de masas sea superior, los picos de
PPG 2000 pueden dar lugar a picos en los que el isótopo más intenso no sea el primero,
lo que puede causar problemas de calibración. Si esto ocurre, estreche el rango de
búsqueda a 0,8.

13. Compruebe que las masas que se enumeran en la lista Reference coincidan con las
masas para las que se adquieren los datos. Si las masas coinciden, continúe en el paso
siguiente. Si las masas no coinciden, haga lo siguiente:

a. Haga clic en Edit.

Se abrirá el cuadro de diálogo Reference Table.

b. Haga coincidir las masas de la lista Reference con las masas para las que se
adquieren los datos, seleccionando o deseleccionando las casillas de verificación
de la columna Use.

c. Haga clic en Update Ref. para guardar los cambios.

d. Haga clic en Close.

14. Haga clic en Start para comenzar la calibración de masas.
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• El software busca el pico más amplio del rango de búsqueda para cada masa y
determina los valores de masa, intensidad y anchura de pico.

• El software compara la masa con la masa prevista y determina el desplazamiento,
si lo hay, compara la anchura de pico con la anchura de pico objetivo y compara
asimismo la intensidad con la calibración anterior.

• El software muestra los resultados de la calibración de masas en un gráfico y en un
informe.

15. Si el software no ha seleccionado el pico correcto para la masa objetivo, excluya el
punto de la calibración.

Sugerencia: Haga clic con el botón derecho en el punto que vaya a excluir y, a
continuación, haga clic en Exclude.

16. Haga clic en Window y, a continuación, en los resultados de calibración.
Se muestra una versión en texto del informe de calibración.

17. En la ventana Calibration report, realice una de las siguientes acciones:

• Para actualizar los valores de las masas modificadas y agregar los valores de
cualquiera de las masas nuevas a la calibración de masas existente, haga clic
en Update Mass Calibration. Solo se sobrescribirán los valores de la calibración
existente de las masas que se hayan calibrado.

• Para reemplazar por completo las masas y los valores existentes por las masas y
los valores nuevos, haga clic en Replace Mass Calibration. Todos los valores de la
calibración existentes se sobrescribirán y aquellas masas que no se hayan calibrado
se eliminarán de la tabla de calibración.

18. Para que los cambios realizados en la calibración de masas tengan efecto, haga clic en
Save.

19. Haga clic en Close.

20. Lleve a cabo un MCA de 10 análisis para comprobar la calibración.

Nota: Repita el procedimiento de calibración, si es necesario.

Calibración manual del espectrómetro de
masas en el modo LIT
Para calibrar el espectrómetro de masas en el modo LIT, lleve a cabo una calibración de
masas de las velocidades de análisis en los modos positivo y negativo.

Siga los procedimientos en el orden especificado:

1. Calibración manual del espectrómetro de masas en el modo LIT

2. Realizar una calibración de masas en el modo LIT
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Seleccionar el método de adquisición para la calibración
manual en el modo LIT
1. Infunda Agilent Mix o PPG 3000 a una velocidad de 5 a10 µl/min.

2. En la barra Navigation, en Tune and Calibrate, haga doble clic en Manual Tuning.

3. (sistemas 3200MD QTRAP). Cree un método de adquisición de resolución mejorada
adecuado a una velocidad de análisis seleccionada o haga clic en File > Open.

4. En la lista Files, seleccione un método en API Instrument > Acquisition Methods >
QTRAP3200.

5. Haga clic en OK.
En Tune Method Editor, se muestran los detalles del método seleccionado.

6. Seleccione un proyecto nuevo de la lista de proyectos y, a continuación, guarde los
datos del método.

Realizar una calibración de masas en el modo LIT
1. En la pestaña MS del Tune Method Editor, asegúrese de que la casilla de verificación

MCA está seleccionada.

2. En la pestaña MS, seleccione la polaridad y la velocidad de análisis.

3. En la sección de la pestaña MSPeriod Summary, escriba Cycles50 en el campo .

4. Haga clic en Start.
Se abrirá un panel de espectros de masas en la parte inferior de la ventana Manual
Tune.

5. Cuando el icono MS esté inactivo, haga clic con el botón derecho en el panel de
espectros de masas y, a continuación, haga clic en Open File.
Se abrirá una ventana nueva con cada ion de interés en un panel independiente.

6. Haga clic con el botón derecho en uno de los paneles de datos y, a continuación, haga
clic en List Data.
Se abrirá un panel nuevo en el que se muestran todos los datos del espectro. Este
panel contiene las pestañas Data List, Calibration Peak List y Peak List.

7. Abra la pestaña Calibration Peak List.

Sugerencia: Esta pestaña solo se muestra si está seleccionada la opción
correspondiente para mostrarla. Para ver la pestaña Calibration Peak List, haga clic
en Tools > Settings > Appearance Options. En la pestaña Miscellaneous, seleccione
la casilla de verificación Show Mass Calibration Peak List y luego haga clic en OK.

8. Haga clic con el botón derecho en la tabla Calibration Peak List y, en el menú
contextual, asegúrese de que se ha seleccionado la tabla de referencia correcta.
Si la tabla de referencia correcta no está seleccionada, seleccione la tabla de referencia
correcta y haga clic en Use as Reference.
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Nota: Si no se muestran todas las masas en la pestaña Calibration Peak List, haga
clic con el botón derecho del ratón en la tabla Calibration Peak List. En el menú
contextual, coloque el cursor en la tabla de referencia que se esté utilizando y, a
continuación, en el submenú haga clic en Edit Reference Table. En el cuadro de
diálogo Reference Table Edit, marque la casilla de verificación Use correspondiente a
las masas que se deben mostrar en la pestaña Calibration Peak List y haga clic en
Update Ref.

9. Revise los datos de la pestaña Calibration Peak List. Si el valor de la columna Mass
Shift (Da) es superior a 0,1 Da para cualquiera de las masas, continúe con el paso
siguiente. En caso contrario, habrá finalizado la calibración de masas.

Nota: Las etiquetas de picos del gráfico son los valores de ápice, pero los valores de
pico indicados en la columna Found At de la pestaña Calibration Peak List son valores
de centroides. Si algún pico no es perfectamente simétrico, el valor de ápice y el del
centroide para ese pico pueden ser ligeramente diferentes. Los valores de centroide
deben ser lo más exactos posible para la calibración.

10. Haga clic en cualquier punto de uno de los paneles de espectro de masas.

11. Haga clic en Tools > Calibrate from Spectrum.
Se abre el cuadro de diálogo Mass Calibration Option.

Figura 2: Cuadro de diálogo Mass Calibration Option

12. En la lista Standard, si se ha utilizado PPG como solución estándar, haga clic en PPGs
Pos. LIT Ref. o PPGs Neg. LIT Ref. en función de la polaridad indicada por el método
de adquisición utilizado.

13. Para cambiar los valores de Peak Search Parameters, haga clic en un campo y, a
continuación, escriba los nuevos valores.
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Los valores predefinidos de Peak Search Parameters son adecuados para la mayoría
de los casos.

14. Compruebe que las masas enumeradas en la lista Reference coinciden con las masas
para las que se adquieren los datos.

Si las masas coinciden, continúe en el paso siguiente. Si las masas no coinciden, realice
los pasos siguientes:

a. Haga clic en Edit.

Se abrirá el cuadro de diálogo Reference Table.

b. Haga coincidir las masas de la lista Reference con las masas para las que se
adquieren los datos, seleccionando o deseleccionando las casillas de verificación
de la columna Use.

c. Haga clic en Update Ref. para guardar los cambios.

15. Haga clic en Start para comenzar la calibración de masas.

• El software busca el pico más amplio del rango de búsqueda para cada masa y
determina los valores de masa, intensidad y anchura de pico.

• El software compara la masa con la masa prevista y determina el desplazamiento,
si lo hay, compara la anchura de pico con la anchura de pico objetivo y compara
asimismo la intensidad con la calibración anterior.

• El software muestra los resultados de la calibración de masas en un gráfico y en un
informe.

Nota: No utilice los indicadores del gráfico de anchuras de pico intermedias, es
decir, las líneas discontinuas. Estos indicadores se han creado para los análisis de
cuádrupolos y no se aplican a los análisis de LIT.

16. Haga clic en Window y, a continuación, en los resultados de calibración.
Se muestra una versión en texto del informe de calibración.

17. Revise los valores de variación de la pendiente. Deben ser de 1,000 ± 0,002. Dado que
el punto de datos más bajo no puede tener pendiente, se mostrará N/A para este punto.

18. Si la diferencia es superior a 0,002, no calibre el espectrómetro de masas. Póngase en
contacto con el soporte de SCIEX en sciex.com/request-support.

19. Si los valores de variación de la pendiente son correctos, vaya a la ventana del informe
de calibración.

20. En la ventana Calibration report, realice una de las siguientes acciones:

• Para actualizar los valores de las masas modificadas y agregar los valores de
cualquiera de las masas nuevas a la calibración de masas existente, haga clic
en Update Mass Calibration. Solo se sobrescribirán los valores de la calibración
existente de las masas que se hayan calibrado.

• Para reemplazar por completo las masas y los valores existentes por las masas y
los valores nuevos, haga clic en Replace Mass Calibration. Todos los valores de la
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calibración existentes se sobrescribirán y aquellas masas que no se hayan calibrado
se eliminarán de la tabla de calibración.

21. Para que los cambios realizados en la calibración de masas tengan efecto, haga clic en
Save.

22. Haga clic en Close.

23. Lleve a cabo un MCA de 10 análisis para comprobar la calibración.

Nota: Repita el procedimiento de calibración, si es necesario.

Iconos de modo de Ajuste y calibración
Icono Nombre Descripción

Calibrate
from
spectrum

Abre el cuadro de diálogo Mass Calibration Option y utiliza el
espectro activo para calibrar el espectrómetro de masas.

Manual Tune Abre el Manual Tune Editor.

Compound
Optimization

Optimiza un compuesto mediante una infusión de FIA.

Instrument
Optimization

Verifica el rendimiento del instrumento, ajusta la calibración de
masas o la configuración del espectrómetro de masas.

View Queue Muestra la cola de muestras.

Instrument
Queue

Muestra un instrumento remoto.

Status for
Remote
Instrument

Muestra el estado de un instrumento remoto.

Reserve
Instrument
for Tuning

Reserva el instrumento para el ajuste y la calibración.

IDA Method
Wizard

Inicia el IDA Method Wizard.
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Contacto

Formación del cliente
• En América del Norte: NA.CustomerTraining@sciex.com

• En Europa: Europe.CustomerTraining@sciex.com

• Fuera de la UE y América del Norte, visite sciex.com/education para obtener información
de contacto.

Centro de aprendizaje en línea
• SCIEX Now Learning Hub

Soporte SCIEX
SCIEX y sus representantes cuentan con un equipo de especialistas técnicos y de servicio
totalmente cualificados en todo el mundo. Ellos sabrán resolver sus dudas y preguntas sobre
el sistema y cualquier problema técnico que pueda surgir. Para obtener más información,
visite el sitio web de SCIEX en sciex.com o póngase en contacto con nosotros de una de las
siguientes formas:

• sciex.com/contact-us

• sciex.com/request-support

Ciberseguridad
Para obtener las indicaciones sobre ciberseguridad más recientes para los productos
SCIEX, visite sciex.com/productsecurity.

Documentación
Esta versión del documento sustituye a todas las versiones anteriores de este documento.

Para ver este documento electrónicamente se necesita Adobe Acrobat Reader. Para
descargar la última versión, vaya a https://get.adobe.com/reader.

Para buscar la documentación relacionada con el producto de software, consulte las notas
de la versión o la guía de instalación del software que se suministra con el software.

Para localizar la documentación relacionada con los productos de hardware, consulte el
DVD Customer Reference que se suministra con el sistema o componente.

Nota: Para solicitar una versión impresa y gratuita de este documento, póngase en contacto
con sciex.com/contact-us.
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